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Configuration Management

What is CM & SCM?

Configuration is the functional and physical
characteristics of hardware and software as
set forth in technical documentation or
achieved in a product



Configuration Management

What is CM & SCM?

Configuration management is unigque
identification, controlled storage, change
control and status reporting of selected
iIntermediate work products, product
components and products during the life of
a system.
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What is CM & SCM?

Software Configuration management is

the task of tracking and controlling changes
In the software throughout its life cycle.
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Why we need it?

Lack of Visibility
Difficulty of Control
Difficult to track
Inconsistency



Configuration Management

SCM process

ldentify Configuration items
Control Configuration items
Perform Configuration audits
Establish CM Records



Configuration Management

SCM process

ldentify Configuration items

. Start of the SCM.

. Identify system components which should
be managed in SCM process.
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SCM process

Control Configuration items

: review the changes and control them to
apply baseline,
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SCM process

Perform Configuration audits

: check the integrity whether changes are
applied properly
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SCM process

Establish CM Records

: record all changes during software life
cycle in documents.
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Terms used in SCM

Version is initial release or re-release of
software configuration item, associated with
a complete compilation or recompilation of
the computer software configuration item

Revision indicate particular points in the s/w
development cycle when there are changes.
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Terms used in SCM

Baseline is a specification or product that has
been formally reviewed an agreed upon, that
thereafter serves as the basis for further
development, and that can be changed only
through formal change control procedures.
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SCM tools

Subversion

Subclipse

TortoiseSVN / RabbitCVS
Github

Redmine
Trac
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Subclipse

L¥ Install

Available Software
Check the iterns that vou wish to install,

Warl with: | subclipse - http://subclipse.tigris, arg/update 1,8,

Mame
7] 4# CollabMet Merge Client
4+ JMA Library
4 Subclipse (Required)
74# Subclipse Integration for Mylyn 3.% {Optional}
DE]EL Subversion Client Adapter (Required)
D@ Subversion JavaHL Mative Library &dapter (Required)
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Subclipse

L} Installing Software

\id) Installing Software

[TEAlwaysrun in backaround:

Run in Eackgrnund] [

Cancel

] [ Details >
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Subclipse

Iv-i},v“ (::Iv - @ﬁ:DEhUQ [ﬁJJE'\-‘E r

) 200711448_23| . wml | [5) 200711448_23]4 %> Debug
2J Java Browsing

& JavaScript

FingletonPracal) :
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Subclipse

[53 %S Repositary Explaring
[4s Database Debug

L_fj; Database Development
%5 Debug

&) Java

£ JJava Browsing

7% Java EE (default)

e Java Type Hierarchy

& JavaScript

P

(1) Planning

<= Plug-in Developrment
E8Remote System Explarer

SOLIECE
%YM Repository Exploring

=1 -\_'l‘_-,-'IIL,iIILIIIi.iiIIH

=
@ Web
3L HML

m

4

0K | [
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° ¥ SWM Fepository Exploring - Pattern/src/SingletonPraca, java - Eclipse
u C I pse File Edit Source Refactor Mavigate Search  Project Bun Window Help

Fﬁ :ﬁ"'uv%v @E‘Q‘ =} | - ¥ (:31
SWM Repositories 532 0 SV Annotate = O\ [J] Main.java [J] SingletonPrz
Qé}:-
public class 3inglet:
i
private =tatic 5
= private Zingletor
i
System. ort.m
h
¥ | Bt Bepository Locs tion, . ihlin static syl
.;\1.><h Refresh if (single ==
i
single= 1
h
return singl
+
+
4
Task Repositories &3 i & History 22
F IGDII\-D

0 Local
a [~ Rnaos
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Subclipse

dSUALSUNSERVER

Need to set up the server
Should get license(Enterprise Edition)
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Subclipse

EQEAEE v/ [ S0 | U0 me HiE P SED W7l | SEa
NAVER 7{2X} MIE] )

- =F-y= —
Fctoe2E CUBRID E3 TZHE Z | LIREE

= CUBRID Manager 2008 R4.1 Patch 1
= CUBRID 2002 R4.1 Patch 1 Source

= CUBRID Interfaces 2008 R4.1 Pa...

= CUBRID 2002 R4.1 Patch 1 Windows
= CUBRID 2002 R4.1 Patch 1 Linux
= CUBRID Manual 2008 R4.1

IHEEXHAE] A4 Lio| I2HE ==
ol B 2E 7SE X6 S24s
HEFHAE] 3WN 2= ZolH s S EZLCH [1] PELM
 [BTIARZ] U018 LR ME| 2122001 T ZULICH 10 EY- TN corapie ' SEHEILICE
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Subclipse

| =2HE ==

e 22 = =2dH 5HEAD

= )

MAELHE= ASW Suiz 22X

TZHEDE
ZZHE ofolC)
TEHME B £

5=

IEEEA B

hellowarld
kdhellowaorld
SN repositoryE H-GEH] RIFFEHIAE

@ 3N (O Git @ Mercurial

[ 212 AR AR IL HER S Mg 23S
=191

—

ol=0] HEhE
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Subclipse

| 2% subversion A5t | DAVS E5t WA Subversion H2
O ZEMEL svy HE-= CIED 22 WHE Bif UHEE H 20t SEHEN HERE SZEIMH = AR 0] EHE MESIE = RlE
Zata = UL LICE saveiopemamres HET HIHM S0 AR BILICL HEHES
. svn checkout —-username anonsvn htkps:/dev, naver, com)svnkdsubclipse MIAEY HZHES HEEIME,
. The passward is 'anonswn' . avn checkout --username gbvalpasams

[https:,l',l'u:lev.naver.cu:um,l'svn,l'k;:lsul:-clipse ]

Subversior(SWHO CHE 24 | & &0k 5 S SLICH

CIEER| 2I7]

o M= : 0 CEED ZHE - 1/1 2E|3| 2IHI & b P
orz FIE 20 AR St FIEHEE 2IHIE

™ branches/ Initial anonsyn 15 2 1

™ tags! Initial anonsyn 15 = 1

£3  trunk/ Initial anons¥n 15 2 1
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Subclipse

£} add SN Repository

Add a new SV Repository

Location

&dd a new SVN Repository to the 5YN Repositories wiew

Url: | https://dev.naver,com/svn,kdsubclipse|

@

[

Finish

| |

Cancel

)
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Subclipse

Add a new SYN Repository
&dd a new SVN Repository to the 5YN Repositories wiew

£} Enter Username and F

SGEIENl Repository: | <https.//dev.naver, corm 443> Document repository

Usernamedy | Adrinistratod

. 1
\la) Password:

[ Save Password:

@ Cancel
Cancel

@ [ Finish ][ Cancel ]
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public static void nwain(String args[])

R
(R

MW ey 3
Go Into

Subclipse

it ln ("3tarc™)

Open in Mew Window a= SingletonPraca.ge
Open Type Hierarchy Fd b= SingletonPraca.dge
Loy Showe In Alt+5hift+ 4

= Copy Cirl+C
5 Copy Gualified Name println("a == hb"):
[ Paste Crl+y

¥ Delete Delete

println(™a !'= b™):
Build Path J
Source Alt+5hift+5
Refactor Alt+5hift+T

v

Exy Import,
e Export,.,

« Refresh F&
Close Project
Close Unrelated Projects Wall

Assign Warking Sets,
false

Bun &s 3 true
Debug As b E;::LL
Emlﬂle Pt k it
Walidate Maty

boply Patch... | /Net

—i Compare With K
Restore from Local History, .

o® Canfiqure bl

Share Project, .
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Subclipse

¥ Share Project

Share Project
select the repository plug-in that will be used to share the selected project, 4=r‘>

select a repository type:
i :
M

1]
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Subclipse

¥ Share Project
Share Project with 5¥N Repository
Select an existing repository location or create a new location, §VN

This wizard will help you to share your files with the SN repository for the first time,
Your project will automatically be imported into the 5YM repository, and the Commit
dialog will open to allow you to commit your resources,

() Create a new repository location
@ {se existing repository [ocation:
[1 https://dev. naver,com/svn/kdsubclipse

@ ke | [ Caneal|
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Subclipse

¥ Share Project

Enter Folder MName
Select the name of the folder in the SWM repositary, ng

(71 Use project name as folder name

@ Use specified folder name: |svntesy

LIRL:
https://dev, naver,com/svn/kdsubclipse/svntest

@:l < Back ][ [Mext ][ Einish ][ Cancel
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Subclipse

-I:} Share Project

Ready to Share Project
=elect Finish to import the project into the SWN repository,

wizard will import your project into the repository and open

The wizard has all the information necessary to share your
project with the SVN repository, When vou click "Finish”, the

the Synchronize view to allow you to commit your resources,

@it the cormmit comment:

Initial import.

o

4\1

<I_hoose a previously entered comment:
Confiqure Cormrment Templates,

@

Finish

| |

Cancel
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Subclipse

oYM (/MetworkPracticeClient, , =
- BE L D

e .
a4 MetworkPracticeClient
B zeftings
a- 78 sro
[Jer CSimpleChatCli
e CSimpleChatClii | [J) Java Source Compare
KE classpath

Java Structure Compare (Cannot Compare Structures)

4

; Local File
KE  project
) Pattern ?uhlic class ClimpleChatClientB
JTextField outgoing:
PrintWriter writer;
Jocket sock;
public void gol()
{
JFrame frame= new JFramwe ("Iimple chat program™):
JPanel mainPanel= new JFanel ()] :
outgoing= new JTextField(20):;
JEButton sendButton= new JButton("Iend™):;
4 T 3 sendButton. addictionlistener (new sSendButtonlListener(l);
; = mainFanel.add (outgoing) ;
Qﬂ1ﬁSkHEDDSmD H - mainFanel.add (sendButton) ;
ET = frame.getContentPane (1 .addiBorderLavout . CENTEER. mwainPanel) :
a [= Tasks !
0 Local g Histary 52 & Tasks| [Z Problemns & 5 o
a4 = Bugs Aestf/src/Main, java in hitps://dev, naver,com/svn/kdsubclipse
. Eclipse.org F.. Date duthor Cornrment

=3 12, 4. 4 2= 946 serapis_
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Subclipse

Commit
Update

Check Out
Compare



Configuration Management

Subclipse

Commit

Apply the changes of the files to the repository
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Subclipse

Update

Get latest files from the repository
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Subclipse

Check Out

Get files from the repository at initial time
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Subclipse

Compare

Compare with last files
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Subclipse

=] ==y — —
|5 Paste Patch Crl+y

ifC

J& CSin

¥ Delete Delete

classpat  Move...

il
Bg
g

[

project Rename... F2

m ntkE
aynchronize

Expand &ll
Bermove from Yiew

a

sow ohow Revision Graph

Malidate

f% gomething changed!!! #f
Tearm L

Compare With L
Replace With »

rame ("Simple chat program™):
JPanel () :
ield(20);
— Lreate Faich,.., new JEutton("Zend™):
Override and Update pListener (new sendbButtonlListeneri()):

Mark as Merged nol :

Lndate

Cornrmnit, ,,

al &dd to Yersion Contral ﬂ e % Ay %7 ﬁ::

fﬂd tc.l SUIInor lcomdsvnfkdsubclipse
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Subclipse

]

i} Save Resource

=

‘CRimpleChatClientB, java’ has been modified, Save changes?

: Yes |[ Mo ][ Cancel ]

Commit to: https://dev.naver.com/svn/kdsubclipse/ svntest/src
Enter & comment far the commit operation,

0404 comment added

<Choose a previously entered comment?
Configure Cormrment Ternplates

Changes [¥] Show unversioned files [C] Keep locks E

4 [7]= MNetworkPracticeClient/src
[Jez CSimplaChatClientB,java

@ ok
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Subclipse

] = 2 AR ZhR} IEHIE 2l
™ Pattern/ serapis_ 11 2 5
™ branches/ Initial anonsYn c0 =2 1
™ swntest/ 0404 comment added serapis_ 49 & g
™ tags/ Initial ANOnsyYn S0 = 1
£ trunk! Initial anonsyn 50 2 1
clHlH 8
EHaHfHZZR0|E g as
St EErapis_

Bl cWed Apr d 20021 2012 KST (3 2, 12 & 0™

EIMAF - 0404 comment added

HANE neE

svntest/sro/

syntestsrc/CIimpleChatClientB. java

added

added

<0
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Subclips_g

ulatar
Test
vorkPracti
o

i tdefault
e[y CSi
;csi
RE Syster
vorkPracti
arn [Pattel
tice

2

public class C3impleChatClient

[ ey

Qpen

Open With

Open Type Hierarchy
Showe In

= Copy
£ Copy Qualified Name
[ Paste
¥ Delete

Build Path
S0UrCe
Refactor

£2g Import,,,
ey Expaort, .,

References
Declarations

«# Refresh
Assign Working Sets, .

Run &s
Debug &s
Erofile &g
Malidate

Caormpare With
Renlara With

Egow UMPULL EvE. LUt a

F3

Fd
Alt+3hift+n

Cirl+C

Cirl+y/
Delete

Alt+Shift+3
Alt+Shift+T

F5

3

v
Y Merge.,,

3

k
k
2

3
, B3 Copy...

3

»
[

& Show History

Es Show Tree Conflicts

[ Show Properties

[ Show Revision Properties
soa Show Revision Graph

) Show Annotation, .,

Update to HE&D

Update to Yersion,..
Create Patch. .,
&pply Patch,,,

Branch/Tag...

Switch to another Branch/Tag/Revision, .,

Show Local Histary

Set Property. ..

Bevert,.,

Lock, ..

Export, .,

ing cha

stratorit

S ELUTE P T LTSNS S T S ST

1.390 bytes

ChatClientt
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Subclipse

i:} |_||:||:|;3tEe =] X
Update Resources B -
|Update the working copy, =
- _____,I
[¥]i{pdate to HEAD revision:
Bevision: ' |
Depth: Working copy -
[T]Change warking copy to specified depth
[]lanare externals
[] &llowe unversioned obstructions
Conflict handling:
Text files:
() Prompt me for each conflict and let me decide
@ Mark conflicts, let me resolve them later
Binary files:
() Prompt me for each conflict and let me decide
@ Mark conflicts, let me resolve them later
() Resolve the conflict by using my version of the file
() Resolve the conflict by using the incoming version of the file
Property conflicts:
() Prompt me for each conflict and let me decide
@ Mark conflicts, let me resolve thermn later
@:‘ (]4 ] [ Cancel
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Subclipse

HHSH I YHS LIS IAS Iy 1%
8 Effﬁi'ﬁ Show In Alt+Shif b
b = Copy Ctrl+C ] -
Pr2 requirer &= Copy Qualified Name I
JRE Syster . Paste Crl+
actice 2= Repositon,
Lo ¥ Delete Delete
public
Build Path > o
Source Alt+Shift+3 » }_,'- pri
Refactor Llt+Shift+T » - — T
aca single= new 3
g=g Import, pri
i3 Export.., ¢
Feferences P lztance Created™); '
Declarations r
puhb.
« Refresh F5 | ZingletonPraca oe {
&ssign Working Sets. .,
Bun As »  Base Revision
Debug As ¥ Latest frorm Repository
Profile &s Revision,,,
Validate Branch/Tag..,
Team ’ 3
Compare With Local Histary, ,, }
p— FReplace With . » | » ¢
. Restore from Local History, . i
singleton Web Services L

' i Downloads

Java - Caompar, .,

e 9 Froperies &lt+Enter
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Subclipse

[J] Java Source Compare w [ <5
Woarkspace file: SingletonPraca, java Repository file: SingletonPraca,java
public class SingletonPraca public class SingletonPraca
i i
/% zomething changed */ /% zomething changed */

/% here change!! */ F’f private static 3JingletonPraca single= ne
private static ZingletonPraca single= new 3

private ZingletonPracal)
private ZingletonPracal) {

{ SIyztem.out.println("Instance Created
Systew.out.println("Instance Created™) : }

public static synchronized 2SingletonPrac

public static synchronized ZingletonPraca os 1
1 if (zingle == null)
if (zingle == null) 1
{ zingle= new ZingletonPracal) :
2ingle= new ZingletonPracal): }
h
return single:;
return single; }

m
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Subclipse applies in project

Developerl
Check Out

Chief Developer l Doing work...

Create

/\%mit
A

Repository W Developer2

N

Doing work...
Commit
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Benefit of SCM

already corrected bugs are avoided
better reputation of company

Concurrent development is simplified
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Requirement Engineering

What is Requirement?

Define the What of a software

What the s/w must do for its stakeholders
34—1 =

= Oy
|
W

=
T\ .
| PN
v




Requirement Engineering

Requirement Engineering

Requirement Engineering is the process of
establishing the services that the customer

requires from a system

concerned with the real-world goals and
constraints on software systems.

Also concerned with evolution over time



Requirement Engineering

Why we need it?

How the sales
executive described it

How the customer  How the project leader  How the engineer How the programmer
explained it understood it designed it wrote it

i

How the customer What the customer

documented installed was billed supported it really needed

How the project was

What operations How the helpdesk



Requirement Engineering

Why we need it?

Multiple view points

Evolution
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RE process

Feasibility study
Requirements analysis
Requirements definition
Requirements validation
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RE process

Feasibility study

: Find out if the current user needs be
satisfied given the available technology and
budget



Requirement Engineering

RE process

Requirements analysis

: Find out what system stakeholders require
from the system
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RE process

Requirements definition

. Define the requirements in a form
understandable to the customer
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RE process

Requirements validation

. validate that defined requirements are
satisfied user’s needs.
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RE tools

JFeature
OSRMT
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JFeature

www.technobuff.net

TECHNOBUFF™

Dralivering effident technaolagy solutions Lagin Free Member Signup
' B '
+ Blogs
] .
FJFeature| JFeature
+ Feeds
) Rate JFeature @ Eclipse Plugin Cent-al Rate JFeature @ Eclipse Plugin Info
+ Link to Us
Click here to vote, Click here to vote,
+ Help .
Introduction
+ Feedhback Synopsis
As & Developer: Did you ever want to know which parts of your cade map to which requirerments? Were you
+ Privacy Policy ever in a situation where you were delivering a drop to QA but not sure whether you had coverad all the
b ’ requirernents?
& Jawa - requirements. jrg - Fclipse SDE = ”HF>~
Bie Bk Mewigate Segrch Brokct Bun Wndow  Help
Download Latest Release g ; . . 7
e L-0O-Q-  BHGF- WP E oo & M BN EY | & 3w
Download Old Yersions Froblens | Jsvados | Decaration | Conscle | Eror Lo [TESSRIIRRY, K-
. r
Home -
- Requirement Coverage Report Humber of Requirements a
. Bng All Caregories i Unibque Test Methads 14
Reqguirement Coverage Summary RequirementsiTest Methads 1:1
Advanced [55,67%) Ratio
o e - .
+ SLUpport (125%)  unmapped Test Methods z
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JFeature

& plugins
OF(Ey MEE) H2 SAHEVNA) EXI ZSEH

Qe=- O - Pz = @
=40 5 C:‘#eclipae—jee—indign—wiﬂ?fo'u‘eclipse‘#plugins]
o 2 EH =29 W - : — :
—
JIEH A ~ U J ol fJ

javax.xwml,.. javax.=ml,..

uff, jfeature

i eclipse
B L 2H _ _ . .
zo 2y _J _J _J _J

@ HWUEN3 =2
R w Jgou oo od
J U u o

pEEEEE org, apach,,,

& W EEH org,eclips,.. org.eclips,., org.eclips... org.eclips...

org,eclips,,, org.eclips,,. org,eclips,,, org.eclips,..

org.eclips... org.eclips,., org.eclips,.. org.eclips,..

org.tigris.... com,colla,,, com.ibri,,, com,jcraft,,,

javax, ach,,, javax.jws,.. javax.mail,.. javax.per,..

nrg.;,jc...
org, n;jl:us...
org. ;ﬁis...
Drg.;;:ijld...
o,

M
Com.sun. ...

I,
A
javax, serny, .,

_

org,apach, .,

]

org,eclips,..

-

org,eclip,.,

_

org.junit_3,.,

JAR

com, triles, ..

JAR |

javax, sery,

-

org,eclips, .,

_

org,eclips,.,

-

org, eclips. .,

-

org.junit_d,,.

JAR |

lava_cup.r,.,

JAR |

javax.tran, .,
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JFeature

avigate Search Project Bun
Ty G BE -
dain.java 23 [J] SingletonPrac

public claszs Main

i

4

roperies B3

perty

Info
derived
editable

i

Window Help

Mewe Window
Mew Editor

Iv{-f,v“ <::Iv

} Ant

public =static void

Systew. cut.prir

Customize Perspective, .,

Save Perspective s,
Beset Perspective, .
Close Perspective

Close all Perspectives
SingletonPraca T
SingletonPraca Mavigation
Ereferences
if(a == h)
{
3ystem.out.println(™a == b"):
E
else
£
Jystem. out.println(a '= b");:
'

Value

false

true

=l Console

%5 Debug

[, Declaration

@] Error Log

@ Javadoc

g Mavigator

o= Outline

[2 Package Explorer

[Zl Problems

& Progress

[ Project Explarer

El Propetties

4 Search

[E] Task List

¥ Tasks

[t Templates
Type Hierarchy

-

[1] CSimpleChatClientB, |

Alt+Shift+0,

Alt+Shift+0,
Alt+3hift+0,

Alt+Shift+Q, J

Alt+5hitt+ll,
Alt+Shift+0,
Alt+3hift+0,

Alt+Shift+0,
Alt+Shift+0,

Alt+Shift+l,

]

Alt+Shift+Q, 0

B &0 Tea
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JFeature

if (& == k)
{
Iyatem. out.println(™a == L") :
H
else
{
System. out.println(fa !'= kb7");

[-= Data Management
[ = Debug

[ = Help

B Java

[ 2= Java Browsing

[ JavaScript

= JavaServer Faces
[ P vt U

m

4= JFeature
JF

[ Mylyn

[ 2= Plug-in Developrnent
[ [ Remote Systermns

[ [ Server

b= BN

Cancel

4
&roperﬁes A JFeature 2

Requirement Coverage Report

2. Run the unit test(s).
3. Refresh the Coverage Report.

\o

1. Associate one or more requirement file(s) with project via "Project->Properties->JFeature”.

-
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JFeature

File -> New -)» Other mm

Select a wizard
Creates a new requirements file. |

Wizards:

[ = Java Run/Debug +
[ = JUnit
= Java EE
= Java Emitter Templates
= JavaScript
= A%E
= JFeaturs

Mew Reguiremnents File
i
= Plug-in Developrnent
= Rermote Systern Explorer
= Server
= S0L Developrnent
= SWN -

| W e i i

m

T R R
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JFeature

-I:} Mew Requiremnents File

New Requirements File

Enter or select the parent folder:
Pattern/src

= calculator
= junitTest
o MetworkPracticeClient [svntest]
= MetworkPracticeServer
o Pattern [Pattern]
3 settings
= bin
[ srC
= practice
T M2

| R O~ P v

T

File name:l requirernents, jr

@ | <Back |

[ Finish ][ Cancel ]
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JFeature

irernents,jrg - Eclipse

arch Project Bun Window Help

~0-Q- | WG~ &S P~
3| [4] Mainjava [J] SingletonPraca, java

- - (::l - e d
[J] CSimpleChatClient,ja

=

Requi,.,. Category Sub Ca...

Title

Target ...  Priority Must .. Test Methods Dependencies

(B of %k M 5 &0 Team Sync... | *
th.] stequirernents,jrg 52 . s =8

&dd Requirement

iel
aty

[Ess

3

[

1 |

T

= Propetties |[iF] JFeature 532

Requirement Coverage Report

1. Associate one or more requirement file(s) with project via "Project->Properties-=]Feature”.
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JFeature

BE $-0-Q- | HE- ®C - | P

r

c o5l rﬁJun = Ju 1 CSimpleChatClientBTest testSetUpMetworking
Ju 2 CalcTest
= £
] calculaturE = Ju 3 calculator
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Benefit of RE

Give whole view of the entire requirements

Able to notice requirement changes
Can check requirements are applied

Easy to track flows of the requirement



Thank you




